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Unit 1 : Introduction to Computer and Operating System 

What is a computer? 

A computer is an electronic device that manipulates information, or data. It has the ability to store, retrieve, 

and process data. You may already know that you can use a computer to type documents, send email, play 

games, and browse the Web. You can also use it to edit or create spreadsheets, presentations, and even videos. 

 

 

  

  

 

 

 

 

 

History / Generations of Computer : 

• First Generation (1940 – 1955) . Example : Electronic Numerical Integrator and Computer (ENIAC) , EDVAC 

• Second Generation (1956 – 1965) : IBM 1401 

• Third Generation (1966 – 1975) : IBM System/360 

• Fourth Generation (1976 – 1985) : Macintosh 128k 

• Fifth Generation (1986 -till date) : Super computer 
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Block Diagram of Computer:  

 

 

 

 

 

 

 

 

 

 

 

1. Input: This is the process of entering data and programs in to the computer system. You should know 

that computer is an electronic machine like any other machine which takes as inputs raw data and performs some 

processing giving out processed data. Therefore, the input unit takes data from us to the computer in an organized 

manner for processing. 

 

2. Storage: The process of saving data and instructions permanently is known as storage. Data has to be fed into 

the system before the actual processing starts. It is because the processing speed of Central Processing 

Unit (CPU) is so fast that the data has to be provided to CPU with the same speed. Therefore the data is first 

stored in the storage unit for faster access and processing. This storage unit or the primary storage of the 

computer system is designed to do the above functionality. It provides space for storing data and instructions. 

 

3. Output: This is the process of producing results from the data for getting useful information. Similarly the 

output produced by the computer after processing must also be kept somewhere inside the computer before being 

given to you in human readable form. Again the output is also stored inside the computer for further processing. 

Arithmetic Logical Unit (ALU)   

 

Logical Unit :After you enter data through the input device it is stored in the primary storage unit. The actual 

processing of the data and instruction are performed by Arithmetic Logical Unit. The major operations performed 

by the ALU are addition, subtraction, multiplication, division, logic and comparison. Data is transferred to ALU 

https://ecomputernotes.com/fundamental/introduction-to-computer/definition-of-computer
https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-cpu
https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-cpu
https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-cpu
https://ecomputernotes.com/fundamental/terms/microprocessor
https://ecomputernotes.com/fundamental/information-technology/what-do-you-mean-by-data-and-information
https://ecomputernotes.com/fundamental/input-output-and-memory/what-is-primary-storage
https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-arithmetic-and-logic-unit-alu
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from storage unit when required. After processing the output is returned back to storage unit for further 

processing or getting stored. 

Control Unit (CU)  

The next component of computer is the Control Unit, which acts like the supervisor seeing that things are done in 

proper fashion. Control Unit is responsible  for  coordinating various operations using time signal. The control 

unit determines the sequence in which computer programs and instructions are executed. Things like processing 

of programs stored in the main memory, interpretation of the instructions and issuing of signals for other units of 

the computer to execute them. It also acts as a switch board operator when several users access the computer 

simultaneously. Thereby it coordinates the activities of computer’s peripheral equipment as they perform the 

input and output. 

 

Central Processing Unit (CPU) 

 

The ALU and the CU of a computer system are jointly known as the central processing unit. You may call CPU 

as the brain of any computer system. It is just like brain that takes all major decisions, makes all sorts of 

calculations and directs different parts of the computer functions by activating and controlling the operations. 

 

Characteristics of computers :  

• Speed 

Computers work at an incredible speed. A powerful computer is capable of performing about 3-4 million simple 

instructions per second. 

• Accuracy 

In addition to being fast, computers are also accurate. Errors that may occur can almost always be attributed to 

human error (inaccurate data, poorly designed system or faulty instructions/programs written by the programmer) 

• Diligence 

Unlike human beings, computers are highly consistent. They do not suffer from human traits of boredom and 

tiredness resulting in lack of concentration. Computers, therefore, are better than human beings in performing 

voluminous and repetitive jobs. 

• Versatility 

Computers are versatile machines and are capable of performing any task as long as it can be broken down into a 

series of logical steps. The presence of computers can be seen in almost every sphere – Railway/Air reservation, 

Banks, Hotels, Weather forecasting and many more. 

• Storage Capacity 

Today’s computers can store large volumes of data. A piece of information once recorded (or stored) in the 

computer, can never be forgotten and can be retrieved almost instantaneously. 

https://ecomputernotes.com/fundamental/introduction-to-computer/control-unit
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Components of Computer : 

Computer : Computer itself a combination of different type of separate electronic device. i.e. Computer only will 

be computer if it has INPUT DEVICE, PROCESS UNIT, and OUTPUT DEVICE. 

• Central Processing Unit (CPU) : It is heart and mind of the computer without this unit computer unable to 

process. 

• Keyboard : This is an input device which is used to input the data into the computer. 

• Mouse : This is also an input device which is used to input the data into the computer. 

• Monitor : This is an output device which is used to show the result of the instructions. 

There are variety of monitor available in the market such as, CRT Monitor, LCD Monitor, Touch Screen Monitor, 

TFT Monitor etc. 

• Switched Mode Power Supply (SMPS) : This is and electronic device which is used to manage the power 

supply of computer. 

• Hard Disk (HDD) : This is used to store the data in massive amount. There are so many type of HDD available 

in the market, i.e. SATA, PATA, External HDD, Internal HDD. 

• Printer : This is an out put device which is used to show the result on the paper. There are plenty of printer 

available in the market like inkjet, Laser printer, dot matrix printer etc. 

Universal Serial Bus (USB) : This is used to connect the external device to the computer. 

• Ethernet Cable : This is used to connect computer with other computer. 

• CD/DVD ROM : This is used to store the data. 

• Speaker : This is an output device which is used to listen voice, songs, etc. 

• Mike : This is an Input device which is used to record the sound . 

 

Computer Software : 

Software is a logical programme to handle/solve the complex problem. 

• System Software : This is special type of software which is responsible for handle the whole computer system. 

• Application Software : This is special type of software which is used to solve a particular problem. 

• Embeded Software : This type of software embeded with hardware to do a specific type of job. 

• Proprietary Software : In general, this type of software require to purchase to use that particular software for 

the some time or single user as per conditioned by the vendor of that particular software. 



 

 

                   DNYANSAGAR ARTS AND COMMERCE COLLEGE, BALEWADI,PUNE–45 

Subject : Computer Concepts and Applications (sub code : 114(B) CBCS 2019-20 Pattern ) 

 Class : F.Y. B.Com 

Prof . S. B. Potadar                                                                                                                                        www.dacc.edu.in 

Open Source Software : This type of software may be freely available and can not be use in commercially. We can 

modify, and use it under the same license. 

 

 

 

Computer Viruses and Security : 

• Virus and worms : These are the computer programme which malfunction the computer system. Virus requires 

a carrier while worms does this by itself. Worm does not requires any carrier. 

• Spoofing : Through this, deceiving the computer users and making the fool. 

• Intrusion or Hacking : If a computer is used and controlled by unauthorised users then it is called hacking and 

who does this is called hacker. Main purpose of hacking to steal the private data or alter the actual data. 

Denial of Services: The main aim of this attack is to bring down the targeted network and make it to deny the 

service for legitimate users. 

Security has always ben an overriding concern of human kind. For many organisation, information plays a very 

important role in running business. Therefore, it becomes necessary to safeguard information from reaching the 

illegal hands. When data takes the shapes of digital form, a different security procedure is required. This branch of 

security is called computer security. 

Information technology has also some loopholes associated with it, like the possibility of stealing of vital 

information and intentionally implanting destructive or malicious programs on the other's computer system. The 

motive behind such activities is to show down the pace of an organisation and harm it economically. We shall 

discuss now about these malicious programs which are often called virus, worms, Trojan horse, logic bomb, 

spyware and os on. 

 

Virus 

Virus is a program which has been written to interfere with the normal functioning of the computer. It does this by 

clogging the memory of the system by making copies of itself or it may destory critical information used by other 

computer prgrams. 

There are three main types of viruses: Boot sector viruses which infect the boot sector in the hard disk and affect 

the partition table, file viruses attach executable files. The commonly infected files are those with COM or EXE 

extensions. The third, system viruses infect specific system files such as command.com. Computer viruses can be 
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grouped into Time Bomb, Trojan Horse, Worm etc. Time Bomb will start on a particular date, at a particular time. 

The computer will loose its ability to function properly. 

The virus known as Trojan Horse will enter into a computer through an e-mail or free programs that have been 

down loaded from the internet and casue plenty of damage. Viruses known as Worms are constructed to infiltrate 

on the legitimate data processing programs and alter or destroy the data. Worm programs often use network 

connections to spread from one computer system to another system, thus, worms attach system that are linked 

through communication lines. 

Protecting computer system using antivirus software 

In case the virus is present, it becomes our duty to use some anti-virus software for preventing virus attacks in 

future. Anti-virus software falls into two categories: Scanners and integrity checkers. 

A scanner is a program that will detect the virus by checking the files on the disk, the boot sector of the disk and 

programs in the memory by looking for the signature of the virus. The signature is a piece of program code that is 

unique to the virus. It is very necessary to update regularly the virus scanner that you have bought. This is essential 

because new viruses are constantly appearing. 

Integrity checkers work using simple checksums or complicated algorithms or cryptographic checksums which 

check if a file 

 

has been modified. It may be boring for you to check for virus every time you run the system. But you should not 

worry. Help is at hand with HomeGuard a unique device which once fitted to the computer automatically scans in 

the background for viruses. If there are viruses found in the system, HomeGuard will clean it up automatically 

without even having to press a key. 

Precautions to be taken against viruses 

• Install a memory-resident program in RAM that will detect and warn if a virus is present. 

• Do not allow hardware engineers or sales persons to put a write enabled floppy into your computer uless they 

can guarantee that it is not infected. 

• Backup copies of all programs and data files should be kept. 

• Backup copies of programs should be held as read-only disks to prevent infection. At least 2 copies of the 

backup must be kept. Never boot your machine with a floppy from an unknown source. 

• Always write-protect your disk when you use it in another machine. 
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Computer Memory : 

Computer’s memory can be classified into two types; primary memory and secondary memory 

RAM 

a. Primary Memory can be further classified as RAM and ROM. 

• RAM or Random Access Memory is the unit in a computer system. It is the place in a computer where the 

operating system, application programs and the data in current use are kept temporarily so that they can be 

accessed by the computer’s processor. It is said to be ‘volatile’ since its contents are accessible only as long as the 

computer is on. The contents of RAM are no more available once the computer is turned off. 

 

ROM or Read Only Memory is a special type of memory which can only be read and contents of which are not 

lost even when the computer is switched off. It typically contains manufacturer’s instructions. Among other things, 

ROM also stores an initial program called the ‘bootstrap loader’ whose function is to start the operation of 

computer system once the power is turned on. 

b. Secondary Memory 

RAM is volatile memory having a limited storage capacity. Secondary/auxiliary memory is storage other than the 

RAM. These include devices that are peripheral and are connected and controlled by the computer to enable 

permanent storage of programs and data. 

• CD ROM 

Secondary storage devices are of two types; magnetic and optical. Magnetic devices include hard disks and optical 

storage devices are CDs, DVDs, Pen drive, Zip drive etc. 

• Hard Disk 

Hard disks are made up of rigid material and are usually a stack of metal disks sealed in a box. The hard disk and 

the hard disk drive exist together as a unit and is a permanent part of the computer where data and programs are 

saved. These disks have storage capacities ranging from 1GB to 80 GB and more. Hard disks are rewritable. 

• Compact Disk 

Compact Disk (CD) is portable disk having data storage capacity between 650-700 MB. It can hold large amount 

of information such as music, full-motion videos, and text etc. CDs can be either read only or read write type. 

CD Drive 

• Digital Video Disk 
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Digital Video Disk (DVD) is similar to a CD but has larger storage capacity and enormous clarity. Depending 

upon the disk type it can store several Gigabytes of data. DVDs are primarily used to store music or movies and 

can be played back on your television or the computer too. These are not rewritable. 

 

 

Input / Output Devices: 

These devices are used to enter information and instructions into a computer for storage or processing and to 

deliver the processed data to a user. Input/Output devices are required for users to communicate with the 

computer. In simple terms, input devices bring information INTO the computer and output devices bring 

information OUT of a computer system. These input/output devices are also known as peripherals since they 

surround the CPU and memory of a computer system. 

Input Devices 

An input device is any device that provides input to a computer. There are many input devices, but the two most 

common ones are a keyboard and mouse. Every key you press on the keyboard and every movement or click you 

make with the mouse sends a specific input signal to the computer. 

Keyboard 

• Keyboard: The keyboard is very much like a standard typewriter keyboard with a few additional keys. The basic 

QWERTY layout of characters is maintained to make it easy to use the system. The additional keys are included to 

perform certain special functions. These are known as function keys that vary in number from keyboard to 

keyboard. 

• Mouse: A device that controls the movement of the cursor or pointer on a display screen. A mouse is a small 

object you can roll along a hard and flat surface. Its name is derived from its shape, which looks a bit like a mouse. 

As you move the mouse, the pointer on the display screen moves in the same direction. 

Trackball: A trackball is an input device used to enter motion data into computers or other electronic devices. It 

serves the same purpose as a mouse, but is designed with a moveable ball on the top, which can be rolled in any 

direction. 

• Touchpad: A touch pad is a device for pointing (controlling input positioning) on a computer display screen. It 

is an alternative to the mouse. Originally incorporated in laptop computers, touch pads are also being made for use 

with desktop computers. A touch pad works by sensing the user’s finger movement and downward pressure. • 

Touch Screen: It allows the user to operate/make selections by simply touching the display screen. A display 

screen that is sensitive to the touch of a finger or stylus. Widely used on ATM machines, retail point-of-sale 

terminals, car navigation systems, medical monitors and industrial control panels. 
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Light Pen: Light pen is an input device that utilizes a light-sensitive detector to select objects on a display screen. 

 

• Magnetic ink character recognition (MICR): MICR can identify character printed with a special ink that 

contains particles of magnetic material. This device particularly finds applications in banking industry. 

• Optical mark recognition (OMR): Optical mark recognition, also called mark sense reader is a technology 

where an OMR device senses the presence or absence of a mark, such as pencil mark. OMR is widely used in tests 

such as aptitude test. 

• Bar code reader: Bar-code readers are photoelectric scanners that read the bar codes or vertical zebra strips 

marks, printed on product containers. These devices are generally used in super markets, bookshops etc. 

• Scanner 

Scanner is an input device that can read text or illustration printed on paper and translates the information 

into a form that the computer can use. A scanner works by digitizing an image.  

 

 

 

 

 

Output Devices: 

Output device receives information from the CPU and presents it to the user in the desired from. The processed 

data, stored in the memory of the computer is sent to the output unit, which then converts it into a form that can be 

understood by the user. The output is usually produced in one of the two ways – on the display device, or on paper 

(hard copy). 

http://oer.nios.ac.in/wiki/index.php/File:Basic6.png
http://oer.nios.ac.in/wiki/index.php/File:Basic7.png
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•Monitor: is often used synonymously with “computer screen” or “display.” Monitor is an output device that 

resembles the television screen (fig. 1.8). It may use a Cathode Ray Tube (CRT) to display information. The 

monitor is associated with a keyboard for manual input of characters and displays the information as it is keyed in. 

It also displays the program or application output. Like the television, monitors are also available in different sizes. 

• Printer: Printers are used to produce paper (commonly known as hard copy) output. Based on the technology 

used, they can be classified as Impact or Non-impact printers. 

Impact printers use the typewriting printing mechanism wherein a hammer strikes the paper through a ribbon in 

order to produce output. Dot-matrix and Character printers fall under this category. 

 

Monitor 

Non-impact printers do not touch the paper while printing. They use chemical, heat or electrical signals to etch the 

symbols on paper. Inkjet, Deskjet, Laser, Thermal printers fall under this category of printers. 

 

 

• Plotter: Plotters are used to print graphical output on paper. It interprets computer commands and makes line 

drawings on paper using multi colored automated pens. It is capable of producing graphs, drawings, charts, maps 

etc. • Facsimile (FAX): Facsimile machine, a device that can send or receive pictures and text over a telephone 

line. Fax machines work by digitizing an image. 

Plotter 

• Sound cards and Speaker(s): An expansion board that enables a computer to manipulate and output sounds. 

Sound cards are necessary for nearly all CD-ROMs and have become commonplace on modern personal 

computers. Sound cards enable the computer to output sound through speakers connected to the board, to record 

sound input from a microphone connected to the computer, and manipulate sound stored on a disk. 

 

 

 

 

 

 

http://oer.nios.ac.in/wiki/index.php/File:Basic9.png
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Computer software:  

is the set of programs that makes the hardware perform a set of tasks in particular order. Hardware and software 

are complimentary to each other. Both have to work together to produce meaningful results. Computer software is 

classified into two broad categories; system software and application software. 

•  

System Software: 

System software consists of a group of programs that control the operations of a computer equipment including 

functions like managing memory, managing peripherals, loading, storing, and is an interface between the 

application programs and the computer. MS DOS (Microsoft’s Disk Operating System), UNIX are examples of 

system software. 

 

 

 

Application software: 

Software that can perform a specific task for the user, such as word processing, accounting, budgeting or payroll, 

fall under the category of application software. Word processors, spreadsheets, database management systems are 

all examples of general purpose application software. 

Types of application software are: 

• Word processing software: The main purpose of this software is to produce documents. MS-Word, Word Pad, 

Notepad and some other text editors are some of the examples of word processing software. 

• Database software: Database is a collection of related data. The purpose of this software is to organize and 

manage data. The advantage of this software is that you can change way data is stored and displayed. MS access, 

dBase, FoxPro, Paradox, and Oracle are some of the examples of database software. 

• Spread sheet software: The spread sheet software is used to maintain budget, financial statements, grade sheets, 

and sales records. The purpose of this software is organizing numbers. It also allows the users to perform simple or 

complex calculations on the numbers entered in rows and columns. MS-Excel is one of the example of spreadsheet 

software. 

• Presentation software: This software is used to display the information in the form of slide show. The three main 

functions of presentation software is editing that allows insertion and formatting of text, including graphics in the 

text and executing the slide shows. The best example for this type of application software is Microsoft 

PowerPoint. 
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• Multimedia software: Media players and real players are the examples of multimedia software. This software 

will allow the user to create audio and videos. The different forms of multimedia software are audio converters, 

players, burners, video encoders and decoders. 
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Unit 2 : Office automation tools 
Ms-Word 

• Create documents fast, using built-in and custom templates and styles. 

• Manage large documents using various features like the ability to create table of contents, index, and cross references.; 

• With the help of mail merge, quickly create and merge documents for mass mailings or create mailing labels; 

• Easily create and format tables using the features like AutoFormat. 

• Auto-Correct and Auto-Format features rectify typo-graphical errors automatically and allows to use predefined shortcuts and typing 

patterns to quickly format the documents. 

• It allows embedding or linking of graphics, spreadsheets, and other objects. 

• The print zoom facility scales a document on different paper sizes, and allows to print out multiple pages on a single sheet of paper. 

• The nested tables feature supports putting one table inside another table. 

• The picture bullets make it easy to insert tiny pictures before each item in a list. 

• Collect and paste lets copy more than one item to the clipboard at a time. One can collect information from many sources and paste it into 

one place. 

• By putting Writer documents on the Web server, one can share information with other people. 

• The multilingual features of Writer allows to type different languages in the same document. 

• Save documents in HTML format. Also create Web Pages using Web Page Wizard. 

• Writer has a powerful feature of built-in drawing tools which allows to create various drawings and graphics. 

• Export your Writer document to PDF including bookmarks. 

 

1. Click on the Start button. 

2. Start menu->All Programmes->Ms Office->Ms Word 

In few seconds you will see OpenOffice.org Writer screen on the monitor. 

You can also start your OpenOffice.org Writer program by simply clicking on OpenOffice.org Shortcut on your desktop and then click the Text 

Document. 

Starting from an existing document 

You can start OpenOffice.org by double-clicking the filename of an OpenOffice.org document in a file manager such as Windows Explorer. The 

appropriate component of OpenOffice.org will start and the document will be loaded. 

You can spot an OpenOffice.org Writer document by its icon:  

Note for Windows users 

http://oer.nios.ac.in/wiki/index.php/File:Writer-2.png
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If you have associated Microsoft Office file types with OpenOffice.org, then when you double-click on a *.doc (Word) file, it opens in Writer; 

*.xls (Excel) files open in Calc, and *.ppt (PowerPoint) files open in Impress. 

The main screen of OpenOffice Writer workspace contains a number of menu objects. We will discuss the main Writer workspace in Print 

Layouthere. 

 

Menus 

The Menu bar is located across the top of the Writer window, just below the Title bar. When you choose one of the menus listed below, a sub-

menu drops down to show the commands for that sub-menu. 

• File menu contains commands that apply to the entire document such as Open..., Save, and Export as PDF.... 

• Edit menu contains commands for editing the document such as Undo: xxx (where xxx is the command to undo) and Find & Replace.... It 

also contains commands to cut, copy, and paste selected parts of your document. 

• View menu contains commands for controlling the display of the document such as Zoom... and Web Layout. 

• Insert menu contains commands for inserting elements into your document such as headers, footers, and pictures. 

• Format menu contains commands for formatting the layout of your document, such as Styles and Formatting, Paragraph, and Bullets 

and Numbering. 

• Table menu shows all commands to insert and edit a table in a text document. 

• Tools menu contains functions such as Spelling and Grammar, Customize..., and Options.... 

http://oer.nios.ac.in/wiki/index.php/File:Writer-1.png
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• Window menu contains commands for the display window. 

• Help menu contains links to the OpenOffice Help file, What’s This?, and information about the program. One can use Help to learn about 

Writer. 

• Toolbars 

Many toolbars displaying shortcut buttons are available to make editing and formatting quicker and easier. Writer has several types of toolbars. 

The toolbar displayed on top position is called the Standard toolbar. The Standard toolbar is consistent across the OpenOffice applications 

(Writer, Calc, Draw, Impress, Base). 

The second toolbar across the top is the Formatting toolbar. It is a context-sensitive bar that shows the relevant tools in response to the cursor’s 

current position or selection. For example, when the cursor is on a graphic, the Formatting bar provides tools for formatting graphics; when the 

cursor is in text, the tools are for formatting text. The formatting toolbars are floating means you can display or hide these toolbars. 

• Displaying or hiding toolbars 

To display or hide toolbars, select View > Toolbars, then click on the name of a toolbar in the list. An active toolbar shows a check mark beside 

its name. 

• Status bar 

The Writer Status bar provides information about the document and convenient ways to quickly change some document features. 

 

Status bar 

• Page number 

Shows the current page number, the sequence number of the current page (if different), and the total number of pages in the document. For 

example, if you restarted page numbering at 1 on the third page, its page number is 1 and its sequence number is 3. 

If any bookmarks have been defined in the document, a right-click on this field pops up a list of such bookmarks; now click on the required one. 

To jump to a specific page in the document, double-click on this field. The Navigator opens. Click in the Page Number field and type the 

sequence number of the required page. After a brief delay, the display jumps to the selected page. 

• Page style 

http://oer.nios.ac.in/wiki/index.php/File:Writer-3.png
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Shows the style of the current page. To change the page style, right-click on this field. A list of page styles pops up; choose a different style by 

clicking on it. To edit the current page style, double-click on this field. 

• Language 

Shows the language for the selected text. Click to open a menu where you can choose another language for the selected text or for the paragraph 

where the cursor is located. You can also choose None (Do not check spelling) to exclude the text from a spelling check or choose More... to 

open the Character dialog. 

Insert mode 

Click to toggle between Insert and Overwrite modes when typing. 

Selection mode 

Click to toggle between STD (Standard), EXT (Extend), ADD (Add) and BLK (Block) selection. EXT is an alternative to Shift+click when 

selecting text. 

Cutting, copying, and pasting text 

Cutting and copying text in Writer is similar to cutting and copying text in other word processing applications such as MS-Word. You can use 

the mouse or the keyboard for these operations. You can copy or move text within a document, or between documents, by dragging or by using 

menu selections, icons, or keyboard shortcuts. You can also copy text from other sources such as Web pages and paste it into a Writer document. 

To move - cut and paste selected text using the mouse, drag it to the new location and release it. To copy selected text, hold down the Control 

key while dragging. The text retains the formatting it had before dragging. 

When you paste text, the result depends on the source of the text and how you paste it. If you click on the Paste icon, any formatting the text has 

(such as bold or italics) is retained. Text pasted from Web sites and other sources may also be placed into frames or tables. If you do not like the 

results, click the Undo icon or press Control+Z. 

To make the pasted text take on the formatting of the surrounding text where it is being pasted, choose either: 

- Edit > Paste Special, or - Click the triangle to the right of the Paste icon, or - Click the Paste icon without releasing the left mouse button. 

Then select Unformatted text from the resulting menu. 

Find and Replace Text 

Writer has two ways to find text within a document. You can use either the Find toolbar for fast searching and the Find & Replace dialog. In 

the dialog, you can: - Find and replace words and phrases - You can use wildcards and regular expressions to fine-tune a search - Find and 

replace specific formatting - Find and replace paragraph styles 
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If the Find toolbar is not visible, you can display it using View > Toolbars > Find 

nd 

To display the Find & Replace dialog, use the keyboard shortcut Control+F or choose Edit > Find & Replace from the menu bar. 

 

 

http://oer.nios.ac.in/wiki/index.php/File:Writer-13.png
http://oer.nios.ac.in/wiki/index.php/File:Writer-14.png
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Find and Replace 

- Type the text you want to find in the Search for box. 

- To replace the text with different text, type the new text in the Replace with box. 

- You can select various options such as matching the case, matching whole words only, or doing a search for similar words. 

- After you have set up your search, click Find. To replace text, click Replace instead. 

Kindly note that, if you click Find All, OpenOffice Writer selects all instances of the search text in the document. Similarly, if you 

click Replace All, OpenOffice writer replaces all matches. 

Tab Setting and indents 

Tab settings affect indentation of full paragraphs using the Increase Indent and Decrease Indent icons on the Formatting toolbar. It also affects 

parts of a paragraph by pressing the Tab key on the keyboard. 

To define indents and tab settings for one or more selected paragraphs, double-click on a part of the ruler that is not between the left and right 

indent icons to open the Indents & Spacing page of the Paragraph dialog. Double-click anywhere between the left and right indent icons on the 

ruler to open the Tabs page of the Paragraph dialog. You can also do this by clicking Format > Paragraph > Indent & Spacing 

You can also define tabs for the paragraph style by clicking Format > Paragraph > Tab. 

In order to set the measurement unit and the spacing of default tab stop intervals, go to Tools > Options > OpenOffice.org Writer > General. 

 

Tab Settings and Indents 

 

 

 

 

 

 

 

 

 

 

 

 

http://oer.nios.ac.in/wiki/index.php/File:Writer-15.png


 

 

                   DNYANSAGAR ARTS AND COMMERCE COLLEGE, BALEWADI,PUNE–45 

Subject : Computer Concepts and Applications (sub code : 114(B) CBCS 2019-20 Pattern ) 

 Class : F.Y. B.Com 

Prof . S. B. Potadar                                                                                                                                        www.dacc.edu.in 

MS-Excel: 

(1) What is spreadsheet package? Give its features, basic components and examples? 

Ans: Spreadsheet package is a software package which is used to create numerical data and store large amount 

of data. Basically it is used in calculation purpose. 

Features:  

(1) It is used in calculation purpose. 

(2) It is used in numerical analysis. 

(3) It is used in creating chart. 

(4) It is used to create report. 

(5) It is used to create accounting information. 

Basic components:  

(1) Row 

(2) Column 

(3) Cell 

(4) Workbook 

(5) Worksheet 

Example of some spreadsheet package:  

(1) Lotus 1-2-3 

(2) Quarto Pro 

(3) VisiCalc 

(4) Microsoft Excel 

(2) What is MS Excel? Give its features and components? 

Ans: MS Excel is a spreadsheet package which is used to create large amount of data. And it is used calculation 

purpose as numerical, statistical and logical calculation is allow. 

Features:  

(1) It is used to store huge amount of data. 

(2) It is used to calculate various type data. 

(3) It is used to create chart and various type graph. 

(4) It is used to create pivot table. 

It is used to create pivot chart and various type numerical data. 



 

 

                   DNYANSAGAR ARTS AND COMMERCE COLLEGE, BALEWADI,PUNE–45 

Subject : Computer Concepts and Applications (sub code : 114(B) CBCS 2019-20 Pattern ) 

 Class : F.Y. B.Com 

Prof . S. B. Potadar                                                                                                                                        www.dacc.edu.in 

(6) It is used to create graph based on financial, business and any other organization. 

Component:  

(1) Chat 

(2) Pivot table. 

(3) Form design 

(4) Pivot chart 

(5) Data validation rule and text 

(6) Sorting data in ascending and descending 

(7) Auto complete, auto calculate, auto sum 

(8) Microsoft office button 

(9) Task pane 

(10) Name box 

(11) Ribbon 

(12) Quick access toolbar 

(13) Status display 

(14) Zoom slider, zoom in, zoom out button 

(15) View button Etc. 

 
 

(3) What is workbook? 

Ans: Workbook is a file of ms excel which has extension name .xls in office 97-2003 and in office 2007 .xlsx. 

One workbook is a collection of various worksheet. 

 
(4) What is worksheet? 

Ans: Worksheet is collection of row and column. Worksheet is a part of workbook. Each page of the 

workbook is called as worksheet. 

(5) What is row, column and cell? How many row, column and cell? 

Ans: Row is the horizontal component of the worksheet. It name as 

1,2,3… Column is the vertical component of the worksheet. It name as 

A,B,C… 

Cell is the intersection of row and column. It name as A1, A2, B1, B2… Total row: 10,48,576 
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Total column: (A-XFD) means 16,384 

Total cells:  1048576 X 16384 = 17179869184 

 
 

(6) What is what-if-analysis? 

Ans: What –if-analysis is the feature of ms excel which is used to change the value automatically if any source 

data changes. 

 
(7) What is auto sum? How to use? 

Ans: Auto sum is the command of ms excel which is used to calculate sum of automatically. In this option also 

available auto average, max, min and count. 

Process: select data range select home ribbon select editing tab select auto sum 

 
 

(8) What is auto calculate? How to use? 

Ans: Auto calculate is a command of ms excel which is used to calculate sum, average, max and min values 

but the result does not stored in the cell. 

Process select data range then show the result on the status bar if you want to change the formula then right 

click on the status bar and select function. 

 
(9) What is auto complete? Give its process? 

Ans: Auto complete is the feature of the excel which is used to matches each current entry with previous entry 

of the same column if it is exist then display automatically. 

 
(10) How to navigate within the worksheet? 

Ans:  

(1) Go to last row  End, Down arrow key 

(2) Go to last column  End, Right arrow key 

(3) Go to first row  End, Up arrow key 

(4) Go to first column  End, Left arrow key 

(5) Go to next worksheet  Ctrl+Shift+Pgdn 

(6) Go to previous worksheet  Ctrl+Shift+Pgup 
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(7) Go to first cell as A1  Ctrl+Home 

(8) Go to one screen left  Alt+Pgup 

(9) Go to one screen right  Alt+Pgdn 

(10) One cell forward  Tab 

(11) One cell backward  Shift+Tab 

 
 

(11) What is mini toolbar? 

Ans:  The Mini Toolbar is a floating toolbar that is displayed when you select or right click text in a 

worksheet. It displayed the common text formatting option. 

 
(12) What is Auto Fill? 

Ans:  The auto fill feature fills a cell data or a series of data in a worksheet into a selected range of cells. This is 

done by entering data into one or more cells and dragging the fill handle to the other cell. 

 
(13) What is Fill handle? 

Ans: The box at the corner of a cell or range that we can use to activate the excel auto fill feature is the fill 

handle. When a cell or range of cells contains data that we can display in increment, drag the fill handle to the 

left, right, up or down to fill a range with data. 

 
(14) How to insert and delete row, column and 

cell? Ans:  

Inserting Row:  

(1) Right click on the row header Insert 

(2) Select row select home ribbon select cells tab select insert select insert sheet rows. 

(3) Right click on the cell Insert Entire 

row Ok Delete Row:  

(1) Right click on the cell Delete Entire row Ok 

(2) Right click on the row header Delete 

(3) Select row select home ribbon select cells tab select delete select delete sheet rows. 

Inserting Column:  
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(1) Right click on the column header Insert 

(2) Select column select home ribbon select cells tab select insert select insert sheet column. 

(3) Right click on the cell Insert Entire 

column Ok Delete column:  

(1) Right click on the cell Delete Entire column Ok 

(2) Right click on the column header Delete 

(3) Select column select home ribbon select cells tab select delete select delete sheet column. 

Insert cells:  

(1) Select cells select home ribbon select cells tab select insert select insert cells select option ok 

(2) Right click on the cell Insert select 

option Ok Delete cells:  

(1) Right click on the cell Delete select option Ok 

(2) Select cell select home ribbon select cells tab select delete select delete cells select option ok 

 
 

(15) How to check spelling and grammar? 

Ans:  Select review ribbon select proofing tab select spelling & grammar option check spelling and 

grammar ok 

 
(16) What is find and replace? How to use it? 

Ans: Find is a command which is used to search particular data within the sheet and replace is a command 

which is used to search particular text and replace with another text. 

Process: select home ribbon select editing tab select find or replace  and type the desire text then find or 

replace text 

 
(17) What is Name box? How to use it? 

Ans: Name box is box which is used to give particular name to a particular data range and it is used easily 

navigate to it. 

Process: select data range select name box give any name press enter. Process for navigating: select name 

box select name which you specify. 
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(18) What is goto command? How to use it? 

Ans: Goto command is used to navigate any data range within the worksheet. 

Process: select home ribbon select editing tab select find & select select goto select reference then ok or 

type new cell reference then ok. 

 
(19) What is cell reference? How many types? Give example? 

Ans:  Cell reference is the row and column address by which cells are often referred to in excel. The address 

contains the column heading followed by the row heading. Cell references are used to locate cell value. 

There are four type cells reference:  

(1) Relative reference:  Here row and column is not fixed. Like A4+G7 etc. 

(2) Absolute reference:  Where row and column both are fixed in particular cell address that it called 

absolute reference. Like $A$5 + H8 

(3) Mixed reference: In mixed referencing row and column both are fixed in different cell address. Like $A6 + 

B$8 

(4) 3D referencing:  3D referencing indicate link between one worksheet to another worksheet. 

 
 

(20) What is formula? Give example? 

Ans: An excel formula is a set of mathematical instruction that can be used to perform calculation in excel 

worksheet. All formulas in excel begin with an equal sign (=) or plus sign (+). 

The component of formula:  

(1) Function 

(2) Reference 

(3) Constants 

(4) Operator 

Example:  =Days360(E1,D1)/100 

 
 

(21) What is Formula Bar? 

Ans:  The formula bar contains the name box, formula box and the insert function button and is located below the 

ribbon. The formula bar provide space to accommodate formulas. 
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(22) What is Function? Give example of common function in excel? 

Ans:  A function is a built in formula in Excel. Function contains a function name followed by arguments within 

parentheses. The function name is the abbreviated name of the function. 

Example of common functions:  

(1) Sum 

(2) Average 

(3) Max 

(4) Min 

(5) Count 

(6) Cou

nta 

Etc. 

(23) What are arguments? Define? 

Ans:  Argument used in function which are the values that the function uses to perform its calculations. 

Example:  Like =Sum(A1:A10) Here A1:A10 are the arguments. 

 
(24) What is Text to Column? Give its use? 

Ans:  Text to Column is commands of ms excel which is used to break a single cell data into more than one 

column data based on space or comma. 

Process: Select cell select data ribbon select data tools tab select text to column followed instruct by 

wizard and finish. 

 
(25) What is Galleries and Live preview? 

Ans:  A gallery is a reposition for elements of the same category. A gallery acts as a central location 

for accessing the various styles and appearance setting for an object. 

 
Live preview:  is a dynamic feature that allows us to preview how formatting options will look on a worksheet 

before we actually apply the selected formatting. 

(26) How to change sheet background? 

Ans:  Select page layout ribbon  select page setup tab  select background select any picture. 
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(27) What is transpose? How to use it? 

Ans:  The transpose option allows us to shift the data in a vertical range of cells to a horizontal range of cells and 

vice versa. 

Process:  select data copy select position select home ribbon select clipboard tab select paste 

option select transpose or select transpose from paste special dialog box. 

 

 

(28) What is default row height and column width? And what are the max and min row and column height 

and width and how to change it? How to hide and unhide row and column? 

Ans:  

Default Row height:  

15 Min Row height:  

0 Max Row height:  

409 

Default Column width:  

8.43 Min Column width: 0 

Max Column width:  255 

 
 

Process of changing row height:  select row  select home ribbon  select cells tab  select format option  

select row height  set row height  ok (We can also use auto fit row height) 

 
Process of changing column width:  select column  select home ribbon  select cells tab  select format 

option  select column width  set column width  ok (We can also use auto fit column width) 

 
Process for hide and unhide row or column:  select rows or columns select home ribbon select cells tab  

select format option  select hide & unhide visibility select hide or unhide option 

(29) How to hide and unhide worksheet? 

(1) select worksheet select home ribbon select cells tab select format option select hide and unhide 

visibility select hide or unhide sheet. 
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(2) Right click on the desire sheet tab select hide or unhide 
 

(30) How to Protect and Unprotect worksheet? 

Ans:  

(1) Right click on the sheet tab select protect sheet give password for protect reenter password 

for protect ok 

(2) Select home tab select cells tab select format option select protect sheet give password reenter 

password ok 

Unprotect sheet:  

(1) Right click on any one of the sheet Unprotect sheet Give password for protect 

(2) Select home tab select cells tab select format option select unprotect sheet give password 
 

(31) What is Text control? How many types? Define briefly? 

Ans:  Text control is commands of ms excel which is used to maintain alignment of data within the cell. 

There are three type of text control:  

(1) Wrap text:  Wrap text is used to set multiple lines within the cell. 

(2) Shrink to fit:  Shrink to fit is used to shrink the contents of the cell and fit into single cell. 

(3) Merge cell  Merge cell is used to combine more than one cell into a single cell. 

Process:  

(1) Select cells right click format cells alignment select any one of text control ok 

(2) Select home ribbon select cells tab select format option select format cells option select 

alignment select any one of the text control Ok 

(32) What are the alignment of number and 

text? Ans:  

Numbers are aligning in right side of the cell. 

Texts are aligning in left side of the cell. 

 
(33) What is auto format? How to apply? 

Ans:  Auto format is a command of ms excels which is used to apply readymade format within the data range. 

Process:  Select data range select auto format option from quick access tool bar ( if it is not found then it add 

by customize quick access toolbar) select any one auto format  ok 
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MS- Power Point 

(1) What is Presentation? 
 

Ans:  A Presentation is a delivery mechanism used to deliver relevant information to specific audiences using 

visual aids. The visual aids can be in the form of overheads, slides, and paper handouts. 

(2) What is PowerPoint? Give its features, components and extension name? 
 

Ans:  PowerPoint is a presentation package which is used to create and edit multimedia package. And design 

various type real life visual impact. 

Features of PowerPoint:  
 

(1) It is used to create and edit any type presentation. 

(2) It is used to create multimedia information. 

(3) It is used to create visual impact. 

(4) It is used to create animation. 

(5) It is used to create animated pictures. 

Components of PowerPoint:  
 

(1) Slide Transition 

(2) Custom Animation 

(3) Custom Show 

(4) Action Button 

(5) Handout Slide 

(6) Rehearse Timing 

(7) Set Up 

Show Extension 

name:  

(1) MS PowerPoint 97-2003 :- .ppt 

(2) MS PowerPoint 2007 and 2010:- .pptx 

(3) What is contextual Tab? How many types? 
 

Ans:  Contextual tabs are sets of additional tabs containing specialized commands that are displayed by 

selecting a specific object type such as text, tables, charts, or pictures. 

There are four type of contextual tabs:  
 

(1) Format 

(2) Design 
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(3) Layout 

(4) Option 

(4) Give some guidelines of designing a good presentation? 
 

Ans:  
 

(1) Identify the critical information that needs to be presented and include in our presentation. 
 

(2) Use no more that six bullet points per slide. 
 

(3) Keep bullet points short and to the point. 
 

(4) Minimize the number of font types used in our presentation. 
 

(5) Keep font sizes consistent. 
 

(6) Do not make all the text uppercase 
 

(7) Remove unnecessary graphics that are not relevant to the information presented. 
 

(5) What is Template? 
 

Ans:  A template is a preconfigured presentation that includes backgrounds and color schemes. Template will 

vary greatly in appearance to suit the many different needs of users. Template can be pre-made by PowerPoint 

or customized for individual use. 

(6) What is slide? Give some example? 
 

Ans:  Slide is a page of PowerPoint which shape is square format where user can fulfill their requirement. 
 

Example:  
 

(1) Title Slide 

(2) Title and Content 

(3) Section Header 

(4) Two Content 

(5) Title Only 

(6) Blank 

(7) Content with caption 

(8) Picture with caption 

(7) What is slide layout? 
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Ans:  A Slide Layout is a predefined template that determines the placement of text and content on a 

slide. Layout can be used to create new slides and applied to existing slides placeholders that can hold 

text, tables, charts, and other slide content are built into a layout. 

(8) What is Galleries? 
 

Ans:  Galleries are libraries that list the varying outcomes of using certain commands found on the ribbon. 

Most of the function groups on the ribbon have galleries, which provide us with a set of predefined styles that 

can be viewed when working on a presentation. 

(9) What is Themes? 
 

Ans:  Themes are design templates that provide a consistent visual look and feel for presentations. Themes 

affect not just the background color of a slide but also that of a diagram, table or any other component present in 

the presentation. 

(10) What is Live Preview? 
 

Ans:  Live Preview features enable us to view the results of the editing and formatting changes made to a 

presentation. 

(11) What is Background Styles? 
 

Ans:  Background styles are standard built in background fill variations that affect only the background of a 

presentation slide. Background styles are derived from the combinations of theme color and background 

intensities in the chosen presentation theme. 

(12) What is text placeholder? 
 

Ans:  Text placeholders are containers where we can type our text. Most of the slide layouts contain one or more 

text place holders. 

(13) What is slide tab? 
 

Ans:  The slide tab displays all the slides available in a presentation and helps to navigate through the 

presentation. 

(14) What is view? How many types? 
 

Ans:  View is component of PowerPoint which is display presentation as various manners. 
 

There are four types of view:  
 

(1) Normal view:  This is default view for creating and editing slides in PowerPoint. 
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(2) Slide sorter:  It is used to view all slide as small images means display as a miniature picture. It is 

also used to rearrange the slides. 

(3) Notes page view:  Displays the content of the notes pane in full page format. 

(4) Slide show:  It is used to show the presentation on screen one slide at a time, as it would be presented 

to an audience. 

(15) Give the different process to run any slide? 
 

Ans:  
 

(1) F5 

(2) Slide show tab From beginning 

(3) View tab Slide Show 

(4) Select Slide show button from status bar view 

button (16)What are typography effects? Give its 

process? 

Ans:  Typography effects are predefined formatting options applied to the text in a presentation. 

Process:  Select text Select Home tab  Select paragraph group Select text direction commands 

(17) What is slide transition? Give its process? 
 

Ans: Slide transitions are effects that are displayed as one slide changes to another during a slide show they 

are only visible when we run the slide show or preview the transition effects. It is basically used to applied 

animation within the slide. 

Process:  Select slide select animation tab select transition to this slide group select any one animation 
 

(18) What is custom animation? Give its process? 
 

Ans:  Custom animation is a command of PowerPoint which is used to add animation within slide component. 
 

Process: Select slide object select animation tab select animation group  select custom animation select 

add effect select any one category  select any one animation 

(19) What is object scaling? 
 

Ans:  Scaling is the process of adjusting the size of an object. 
 

(20) What is image compression? Give its process? 
 

Ans:  Image compression is a technique in which we can use to reduce the file size of an image. Reducing 

the file of the images in our presentation greatly reduce the file size of the presentation. 
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Process:  Select the picture Select format contextual tab Select adjust group Select compress pictures 

 

(21) What is orientation? Give its process? 
 

Ans:  Orientation is the angle at which an object appears on a slide. It is also known as rotation. It is measured 

in degrees from 0 to 360. But in page setup orientation indicate two type portrait which is known as height more 

than width and landscape is known width more than height. 

Process:  Select object Select format contextual tab Select arrange group from rotate drop down list, select 

the required rotation option. 

(22) What is group and ungroup? Give its process? 
 

Ans:  Grouping is a technique in which multiple objects can be grouped together to form a single entity. Any 

modification make to a group will affect all the objects in that group. 

And ungroup in the technique of breaking a group object single object to more than one object. 
 

Process:  (1) Select objects Right click on it Grouping Select group or ungroup 
 

(2) Select object Select format contextual tab Select 

arrange group Select group or ungroup 

(23) What is order of objects? Give its process? 
 

Ans:  The order of objects determines how overlapping objects appear in relation to each other. The object on 

the top layer will be completely visible, whereas the visibility of the object on the bottom layer will be 

obstructed by all the objects above it. 

Process  (1) Select the object Right click on it Order Select any one 

option (2)Select the object  Select format contextual tab Select 

arrange 

group Select layering option Select any one option 
 

(24) What is custom show? How to create, delete and run? 

Ans:  Custom show is a presentation within the 

presentation. Creating custom show:- 

Select slide show tab Select custom slide show Select custom show New Give custom show name Add 

slide which you want Ok Close 
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Delete custom show:- 

Select slide show tab Select custom slide show select custom show select custom show name Remove Run 

custom show:- 

Select slide show tab select custom slide show select custom show name, which you want to run 
 

(25) What is animation? How many types? Define 
 

Ans: Animation effects are predefined special effects applied to objects on a slide that determine the way the 

objects will appear during a presentation. 

There are three type animations: 
 

(1) Fade: Slowly brings the object onto the slide. 

(2) Wipe:Quickly brings the object onto the slide. 

Fly in: Makes the object fly onto the slide. 
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Unit 3 Introduction to Computer Network 

A computer network is interconnection of various computer systems located at different places. In computer 

network two or more computers are linked together with a medium and data communication devices for the 

purpose of communicating data and sharing resources. The computer that provides resources to other computers 

on a network is known as server. In the network the individual computers, which access shared network resources, 

are known as nodes. 

Characteristics of a Computer Network 

The primary purpose of a computer network is to share resources: 

• You can play a CD music from one computer while sitting on another computer 

• You may have a computer that doesn’t have a DVD or BluRay (BD) player. In this case, you can place a 

movie disc (DVD or BD) on the computer that has the player, and then view the movie on a computer that 

lacks the player 

• You may have a computer with a CD/DVD/BD writer or a backup system but the other computer doesn’t have 

it. In this case, you can burn discs or make backups on a computer that has one of these but using data from a 

computer that doesn’t have a disc writer or a backup system 

• You can connect a printer (or a scanner, or a fax machine) to one computer and let other computers of the 

network print (or scan, or fax) to that printer (or scanner, or fax machine) 

• You can place a disc with pictures on one computer and let other computers access those pictures 

• You can create files and store them in one computer, then access those files from the other computer(s) 

connected to it 

Concept of Networking: 

A computer network, often simply referred to as a network, is a collection of hardware components and computers 

interconnected by communication channels that allow sharing of resources and information. Networks may be 

classified according to a wide variety of characteristics such as the medium used to transport the data, 

communications protocol used, scale, topology, and organizational scope. The rules and data formats for 

exchanging information in a computer network are defined by communications protocols. 

Properties of Network 
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1. Facilitate communications: 

Using a network, people can communicate efficiently and easily via email, instant messaging, chat rooms, 

telephone, video telephone calls, and video conferencing. 

2. Permit sharing of files, data, and other types of information 

In a network environment, authorized users may access data and information stored on other computers on the 

network. The capability of providing access to data and information on shared storage devices is an important 

feature of many networks. 

3. Share network and computing resources 

In a networked environment, each computer on a network may access and use resources provided by devices on 

the network, such as printing a document on a shared network printer. Distributed computing uses computing 

resources across a network to accomplish tasks. 

BENEFITS OF NETWORK 

• File sharing: Network file sharing between computers gives you more flexibity than using floppy drives or Zip 

drives. Not only can you share photos, music files, and documents, you can also use a home network to save 

copies of all of your important data on a different computer. Backups are one of the most critical yet 

overlooked tasks in home networking. 

• Printer / peripheral sharing: Once a home network is in place, it’s easy to then set up all of the computers to 

share a single printer. No longer will you need to bounce from one system or another just to print out an email 

message. Other computer peripherals can be shared similarly such as network scanners, Web cams, and CD 

burners. 

• Internet connection sharing: Using a home network, multiple family members can access the Internet 

simultaneously without having to pay an ISP for multiple accounts. You will notice the Internet connection 

slows down when several people share it, but broadband Internet can handle the extra load with little trouble. 

Sharing dial-up Internet connections works, too. Painfully slow sometimes, you will still appreciate having 

shared dial-up on those occasions you really need it. 

• Multi-player games: Many popular home computer games support LAN mode where friends and family can 

play together, if they have their computers networked. 

• Internet telephone service: Voice over IP (VoIP) services allows you to make and receive phone calls through 

your home network across the Internet. 
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• Home entertainment: Newer home entertainment products such as digital video recorders (DVRs) and video 

game consoles now support either wired or wireless home networking. Having these products integrated into 

your network enables online Internet gaming, video sharing and other advanced features. 

TYPES OF NETWORK 

There are many different types of networks. However, from an end user’s point of view there are three basic types: 

• Local Area Network 

• Metropolitan Network 

• Wide Area Network 

Local Area Network (LAN): 

A local area network (LAN) supplies networking capability to a group of computers in close proximity to each 

other such as in an office building, a school, or a home. A LAN is useful for sharing resources like files, printers, 

games or other applications. A LAN in turn often connects to other LANs, and to the Internet or other WAN. 

Most local area networks are built with relatively inexpensive hardware such as Ethernet cables, network adapters, 

and hubs. Wireless LAN and other more advanced LAN hardware options also exist. LAN is a computer network 

that spans a relatively small area. Most LANs are confined to a single building or group of buildings. However, 

one LAN can be connected to other LANs over any distance via telephone lines and radio waves. Most LANs as 

(shown in Fig. 2.6) connect workstations and personal computers. Each node (individual computer) in a LAN has 

its own CPU with which it executes programs, but it is also able to access data and devices anywhere on the LAN. 

This means that many users can share expensive devices, such as laser printers, as well as data. Users can also use 

the LAN to communicate with each other, by sending e-mail or engaging in chat sessions. There are many 

different types of LANs-token-ring networks, Ethernents, and ARCnets being the most common for PCs. 

Wide Area Networks (WANs) 

The term Wide Area Network (WAN) usually refers to a network which covers a large geographical area, and use 

communications circuits to connect the intermediate nodes. A major factor impacting WAN design and 

performance is a requirement that they lease communications circuits from telephone companies or other 

communications carriers. Transmission rates are typically 2 Mbps, 34 Mbps, 45 Mbps, 155 Mbps, 625 Mbps (or 

sometimes considerably more). 

Metropolitan Area Network (MAN) 

A Metropolitan Area Network (MAN) is one of a number of types of networks (see also LAN and WAN). A MAN 

is a relatively new class of network, it serves a role similar to an ISP, but for corporate users with large LANs. 
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IMPORTANT TERMS USED IN NETWORKING 

Voice Messaging 

It is a new communication approach which is similar to electronic mail except that it is audio message rather than 

text messages that are processed. A sender speaks into a telephone rather than typing, giving the name of the 

recipient and the message. That sender’s voice signal is then digitized and stored. The system can then either 

deliver the message at a specified time in future or it can be retrieved from a database by the recipient. The 

message is reconverted back into its analog format when it is delivered or retrieved so that the recipient hears it as 

the original sender’s voice on a telephone. Voice messaging requires a computer with an ability to store the audio 

messages in digital form and then convert them back in an audio form upon verification. Each user has a voice 

mailbox in secondary storage and special equipment converts the audio message to and from the digital form. The 

main advantage of voice mail over electronic mail is that the sender does not have to type. Voice mail also makes 

it easy to include people in the firm’s environment in an communication network. 

Hub 

A hub is typically the least expensive, least intelligent, and least complicated of the three. Its job is very simple: 

anything that comes in one port is sent out to the others. That’s it. Every computer connected to the hub “sees” 

everything that every other computer on the hub sees. The hub itself is blissfully ignorant of the data being 

transmitted. For years, simple hubs have been quick and easy ways to connect computers in small networks. 

Switch 

A switch does essentially what a hub does but more efficiently. By paying attention to the traffic that comes across 

it, it can “learn” where particular addresses are. For example, if it sees traffic from machine A coming in on port 2, 

it now knows that machine A is connected to that port and that traffic to machine A needs to only be sent to that 

port and not any of the others. The net result of using a switch over a hub is that most of the network traffic only 

goes where it needs to rather than to every port. On busy networks this can make the network significantly faster. 

Router 

A router is the smartest and most complicated of the bunch. Routers come in all shapes and sizes from the small 

four-port broadband routers that are very popular right now to the large industrial strength devices that drive the 

internet itself. A simple way to think of a router is as a computer that can be programmed to understand, possibly 

manipulate, and route the data its being asked to handle. For example, broadband routers include the ability to 

“hide” computers behind a type of firewall which involves slightly modifying the packets of network traffic as 

they traverse the device. All routers include some kind of user interface for configuring how the router will treat 

traffic. The really large routers include the equivalent of a full-blown programming language to describe how they 
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should operate as well as the ability to communicate with other routers to describe or determine the best way to get 

network traffic from point A to point B. 

Network Repeater 

A repeater connects two segments of your network cable. It retimes and regenerates the signals to proper 

amplitudes and sends them to the other segments. When talking about, ethernet topology, you are probably talking 

about using a hub as a repeater. Repeaters require a small amount of time to regenerate the signal. This can cause a 

propagation delay which can affect network communication when there are several repeaters in a row. Many 

network architectures limit the number of repeaters that can be used in a row. Repeaters work only at the physical 

layer of the OSI network model. 

Bridge 

A bridge reads the outermost section of data on the data packet, to tell where the message is going. It reduces the 

traffic on other network segments, since it does not send all packets. Bridges can be programmed to reject packets 

from particular networks. Bridging occurs at the data link layer of the OSI model, which means the bridge cannot 

read IP addresses, but only the outermost hardware address of the packet. In our case the bridge can read the 

ethernet data which gives the hardware address of the destination address, not the IP address. Bridges forward all 

broadcast messages. Only a special bridge called a translation bridge will allow two networks of different 

architectures to be connected. Bridges do not normally allow connection of networks with different architectures. 

The hardware address is also called the MAC (media access control) address. To determine the network segment a 

MAC address belongs to, bridges use one of: 

• Transparent Bridging: They build a table of addresses (bridging table) as they receive packets. If the address is 

not in the bridging table, the packet is forwarded to all segments other than the one it came from. This type of 

bridge is used on ethernet networks. 

• Source route bridging: The source computer provides path information inside the packet. This is used on 

Token Ring networks 

Router 

There is a device called a router which will function similar to a bridge for network transport protocols that are not 

routable, and will function as a router for routable protocols. It functions at the network and data link layers of the 

OSI network model. 

Gateway 

A gateway can translate information between different network data formats or network architectures. It can 

translate TCP/IP to AppleTalk so computers supporting TCP/IP can communicate with Apple brand computers. 
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Most gateways operate at the application layer, but can operate at the network or session layer of the OSI model. 

Gateways will start at the lower level and strip information until it gets to the required level and repackage the 

information and work its way back toward the hardware layer of the OSI model. 

 

What is Internet ? 

In 1969, the U.S. Defence Department funded a project to develop a network, which can withstand the bombing. 

Basically the idea was to develop a very secure network which can work even after a nuclear attack. This project 

was known as ARPANET. The proposed network was not supposed to have a central control – which would be an 

obvious target. Ten years of research brought Local Area Ethernet Networks (LANs) and workstations were 

developed to get connected to LAN. These workstations and LANs were then connected to the ARPANET. 

Internet Networking 

For next decade the ARPANET grew and its decentralized features helped its rapid expansion. Computers 

connected to ARPANET used to standard or rule to communicate with each other. This standard used by 

ARPANET is known as NCP (National Control Protocol). Protocol is a network term used to indicate the standard 

used by a network for communication. But the passing time and rapid change in information technology 

suppressed NCP and brought TCP/IP (Transmission Control Protocol/Internet Protocol) in to the world of 

networking. TCP converts messages into streams of packets at the source, and they are reassembled back into 

messages at the destination. IP handles the dispatch of these packets. It handles the addressing, and makes sure that 

a packet reaches its destination through multiple nodes and even across multiple networks with multiple standards. 

This flexibility of TCP/IP to handle multiple networks with multiple protocols encourages other networks to get 

connected to ARPANET. Slowly the ARPANET became a massive network of networks and now it is known as 

‘Internet’. 

The Internet is a global system of interconnected computer networks that use the standard Internet protocol suite 

(TCP/ IP) to serve billions of users worldwide. It is a network of networks that consists of millions of private, 

public, academic, business, and government networks, of local to global scope, that are linked by a broad array of 

electronic, wireless and optical networking technologies. The Internet carries a vast range of information resources 

and services, such as the inter-linked hypertext documents of the World Wide Web (WWW) and the infrastructure 

to support electronic mail. 

Uses of Internet 

Internet has been the most useful technology of the modern times which helps us not only in our daily lives, but 

also our personal and professional lives developments. The internet helps us achieve this in several different ways. 



 

 

                   DNYANSAGAR ARTS AND COMMERCE COLLEGE, BALEWADI,PUNE–45 

Subject : Computer Concepts and Applications (sub code : 114(B) CBCS 2019-20 Pattern ) 

 Class : F.Y. B.Com 

Prof . S. B. Potadar                                                                                                                                        www.dacc.edu.in 

For the students and educational purposes the internet is widely used to gather information so as to do the research 

or add to the knowledge of various subjects. Even the business professionals and the professions like doctors, 

access the internet to filter the necessary information for their use. The internet is therefore the largest 

encyclopedia for everyone, in all age categories. The internet has served to be more useful in maintaining contacts 

with friends and relatives who live abroad permanently. 

Advantages of Internet: 

• E-mail: Email is an essential communication tools in todays world. With e-mail one can send and receive instant 

electronic messages, which works like writing letters. Messages are delivered instantly to people anywhere in the 

world, unlike traditional mail that takes a lot of time. Email is free, fast and very cheap when compared to 

telephone, fax and postal services. 

• 24 hours a day - 7 days a week: Internet is available, 24x7 days for usage. 

• 'Information: There is a huge amount of information available on the internet for just about every subject, 

ranging from government law and services, trade fairs and conferences, market information, new ideas and 

technical support. One can find any type of data on almost any kind of subject by using search engines like google, 

yahoo, msn, etc. 

• Online Chat: Chat facility can be used to meet new people, make new friends, as well as to stay in touch with 

friends. Commonly used chat messangers are MSN, gmail and yahoo websites. 

• Services: Many services are provided on the internet like net banking, job searching, purchasing tickets, hotel 

reservations, guidance services on array of topics engulfing the every aspect of life. 

• Communities: Communities of all types have sprung up on the internet. Its a great way to meet up with people 

of similar interest and discuss common issues. 

• Shopping: There are many online stores and sites that can be used to look for products as well as buy them using 

credit card. Through internet all shopping could be done sitting conveniently @ your home. 

• Entertainment: Internet provides facility to access wide range of Audio/Video songs, plays films. Many of 

which can be downloaded. One such popular website is YouTube. 

• Software Downloads: You can freely download innumerable, softwares like utilities, games, music, videos, 

movies, etc from the Internet. 

Limitations of Internet 

• Theft of Personal information: With the use of Internet there are chances that personal information such as 

name, address, credit card, bank details and other information can be accessed by unauthorized persons. If you use 

a credit card or internet banking for online shopping, then your details can also be ‘stolen’. 

http://oer.nios.ac.in/wiki/index.php/INTERNET_COMMUNICATIONS#E-MAIL
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• Most parents do not realize the dangers involved when their children log onto the Internet. When children talk to 

others online, they do not realize they could actually be talking to a harmful person. Moreover, pornography is also 

a very serious issue concerning the Internet, especially when it comes to young children. 

 

• Virus threat: Virus is a program created to disrupts the normal functioning of computer systems. Computers 

attached to internet are more prone to virus attacks and they can end up into crashing your whole hard disk. 

 

• Spamming: It is often viewed as the act of sending unsolicited email. This multiple or vast emailing is often 

compared to mass junk mailings. 

 

• Phishing : Phishing attack refers to sending a convincing mail to targetted user with an embedded url in the 

same. When the user clicks the url it directs the user to the phishing website. And when the person enters there 

personal details , the same is utilized by phisher to transfer money. 

 

But what does one do with the Internet? May be four things, basically: mail, discussion groups, long-distance 

computing, and file transfers. Internet mail is (e-mail or electronic mail), much faster as compared to normal postal 

mail. One can also send software and certain forms of compressed digital image as an attachment. News groups or 

discussion groups facilitate Internet user to join for various kinds of debate, discussion and news sharing. Long-

distance computing was an original inspiration for development of ARPANET and does still provide a very useful 

service on Internet. Programmers can maintain accounts on distant, powerful computers, execute programs. File 

transfer service allows Internet users to access remote machines and retrieve programs, data or text. 

(a) Internet Applications 

We can roughly separate internet applications into the following types: media, information search, 

communications,communities, entertainment, e-business, finance and other applications. 

The internet is treated as one of the biggest invention. It has a large number of uses.. 

1. Communication 

2. Job searches 

3. Finding books and study material 

4. Health and medicine 
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5. Travel 

6. Entertainment 

7. Shopping 

8. Stock market updates 

9. Research 

10. Business use of internet: There are different ways by which intenet can be used for business are: 

• Information about the product can be provided online to the the customer . 

• Provide market information to the business eg Stock Market 

• It help business to recruit talented people. 

• Help in locating suppliers of the product 

• Feedback and reviews about companies product 

• Eliminate middle men and have a direct contact with customer . 

• Providing information to the investor by providing companies back ground and financial information on 

web site. 

Web Browser 

A web browser is an interface that helps a computer user gain access to all the content that is on the Internet and 

the hard disk of the computer. It can view images, text documents, audio and video files, games, etc. More than 

one web browser can also be installed on a single computer. The user can navigate through files, folders and 

websites with the help of a browser. When the browser is used for browsing web pages, the pages may contain 

certain links which can be opened in a new browser. Multiple tabs and windows of the same browser can also be 

opened.There are four leading web browsers: Explorer, FireFox, Netscape and Safari but there are many others 

browsers available. 

• Netscape 

Netscape is one of the original Web browsers. This is what Microsoft designed Internet Explorer to compete 

against. Netscape and IE comprise the major portion of the browser market. Netscape was introduced in 1994. 

• Internet Explorer 

Internet Explorer (IE) is a product from software giant Microsoft. This is the most commonly used 

browser in the universe. This was introduced in 1995 along with Windows 95 launch and it has passed 

Netscape popularity in 1998. 
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• Safari 

Safari is a web browser developed by Apple Inc. and included in Mac OS X. It was first released as a 

public beta in January 2003. Safari has very good support for latest technologies like XHTML, CSS2 

etc. 

 

• Firefox 

Firefox is a new browser derived from Mozilla. It was released in 2004 and has grown to be the 

second most popular browser on the Internet. 

 

• Opera 

Opera is smaller and faster than most other browsers, yet it is full- featured. Fast, user-

friendly, with keyboard interface, multiple windows, zoom functions, and more. Java and non 

Java-enabled versions available. Ideal for newcomers to the Internet, school children, handicap 

and as a front-end for CD-Rom and kiosks. 

 

• Google Chrome 

This web browser was developed by Google. Its beta and commercial versions were 

released in September 2008 for Microsoft Windows. It has soon become the fourth-most 

widely used web browser with a market share of 1.23%. The browser versions for Mac OS 

X are under development. The browser options are very similar to that of Safari, the 

settings locations are similar to Internet Explorer 7, and the window design is based on 

Windows Vista. 
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Unit 4 Computer applications in Commerce 

 Computer application in Business:  

Needs and Scope: 

 It has great need to use computer applications in business. because world become a global market and everyone 

want to buy a good quality product and ideas. we can share our ideas through computer aplicantion sell our ideas 

and discuse about new product. 5.3 Computer Application in various fields of Commerce: Almost every business 

uses computers to complete daily tasks. From making contact with clients to inputting data for reports, computers 

allow businesses a more efficient way to manage affairs when compared to traditional paper and manila folders. 

Businesses use a variety of different types of computers such as desktops, laptops, servers, smartphones and 

tablets, depending on their needs. With computers, employees are able to work anytime, anywhere. 

Communication Communication is key when gaining and maintaining clients and other important contacts. 

Computers give businesses access to email, instant messaging and custom customer contact systems. 

Computerized phone systems allow for automated support during off hours and a virtual operator can quickly 

direct callers to the correct department for faster support.  

1. Marketing Computers allow businesses to create websites, stunning ads and complete marketing campaigns. 

Marketing videos can be edited and custom ads created in-house with the use of specialized software. Businesses 

can completely develop and manage websites with their own servers or connect remotely to a third-party business 

to upload their latest content such as articles, product images and blog posts.  

2. Accounting Accounting without computers presents a high risk for human error. Accounting software allows 

businesses to simply input their financial data and instantly see gains and losses. All necessary tax reports are 

available the moment the data is entered. Using computers for invoicing, managing expenses and calculating 

payroll is vital for ensuring financial data is as accurate as possible.  

3. Storage Instead of filing cabinets, businesses are able to store millions of files using computers and servers. 

Data can be stored centrally for easy access from multiple computers or stored locally for individual use. 

Computerized storage saves space and provides a far more efficient organization strategy. With encryption, 

passwords and replace keys, data remains secure.  

4. Documents and Reports Most businesses have some sort of productivity software which typically includes a 

word processor and spreadsheet application. These two programs allow businesses to create reports, memos, 

tutorials and even colorful ads for company events. Spreadsheet applications give businesses the chance to 

organize, manage and calculate both numeric and alphabetic data. With charts and graphs, reporting becomes 
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visual instead of text-based. 5. Education Businesses use computers to help educate employees on software, 

company policy, standard procedures and safety. Instead of hiring teachers, computers can be used to educate 

employees at their own pace or through an online webinar with live questions and answers. This form of education 

fits the busy schedules of businesses without sacrificing the quality of the education. 

 

5.3.1 Personal Administration (Human Resources) Personnel Administration, commonly known as Human 

Resources or HR, handles a great many issues in the workplace. The primary function is the recruiting selecting 

and hiring of new employees, but goes way beyond that in most companies. Human Resources is also responsible 

to see that workplace standards meet legal and ethical criteria, including the manner in which employees are 

treated by their supervisors. In some companies, HR is responsible for employee training, although this is often 

done by the department hiring the new employee. HR also administers employee benefits programs and keeps 

track of sick time and vacations. Employee guides are also created by Human Resources, usually with the 

assistance of an attorney knowledgeable in personnel law.  

Accounting Definition -The Systematic recording ,reporting and analysis of financial transactions of a business. 

Cost and Budgetary management:- Preparing a budget is an integral part of establishing the business case for a 

project. An evaluation of the financial requirements is central to establishing whether the project is viable or not. 

In cases where external funding is being applied for, the budget will form an important element of the bid and the 

benefits model. At the most fundamental level, budgeting should answer the questions: • ‘What is the cost of 

undertaking this project?’ • ‘Is any external funding sufficient to cover the costs?’ • ‘Where there is competition 

for resources, is this project a priority?’, and • ‘To what degree do cost and benefit balance up?’ Purchasing:- The 

activity of acquiring goods or services to accomplish the goals of an organization.  

The major objectives of purchasing are to  

(1) maintain the quality and value of a company's products 

(2) minimize cash tied-up in inventory 

(3) maintain the flow of inputs to maintain the flow of outputs  

(4) strengthen the organization's competitive position. Purchasing may also involve  

(a) development and review of the product specifications 

 (b) receipt and processing of requisitions  

(c) advertising for bids 

(d) bid evaluation 
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 (e) award of supply contracts 

 (f) inspection of good received 

(g) their appropriate storage and release. 

 

Stock-Broking:- The process of investing in the share market, either individually or through a broker is known as 

stock broking, in simple terms. This is primarily done by opening a Demat account. If done through a broker, he 

opens an account, helping you to operate through online stock broking facility. Going ahead the broker suggests 

investment ideas and strategies suiting individual requirements and based on his objective of investment. Tenure 

of investment, the selected financial instruments and their respective companies, the schemes, the risk taking 

ability, the sum available for investment, all are considered while forming investment choices. After the amount is 

invested, the broker tracks and monitors the investments, changes or reinvests depending on the performance and 

generates reports for them. This entire process is known as stock broking.  

Banking: Banking is a business of accepting deposits and lending money. It is carried out by financial 

intermediaries, which performs the functions of safeguarding deposits and providing loans to the public. In other 

words, Banking means accepting for the purpose of lending or investment of deposits of money from public 

repayable on demand and can be withdrawn by cheque, draft order and so on.  

Banking Company: Any company, which transacts the business of banking Banking System is a principal 

mechanism through which the money supply of the country is created and controlled. The banking system enables 

us to understand Commercial Banks, Secondary Banks, Central Banks, Merchant Bank or Accepting Houses and 

Discount Houses but to exclude the Saving Banks and Investment and other intermediaries.  

Insurance: Insurance is a contract between the insurer and the insured wherein against receipt of certain amount, 

called premium, the insurer agrees to make good any financial loss that may be suffered by the insured, due to the 

operation of an insured peril on the subject matter of insurance. The Life is full of uncertainties.. People opt for 

insurance purely for the reasons of uncertainties in life. Insurance gives the insured a kind of peace of mind as he 

is assured to making up the loss in the event of such uncertainties in life happen.  

Insurance business is divided into four classes , namely : 1) Life Insurance. Popular Products in Life insurance 

are Endowment Assurance (Participating), and Money Back (Participating). More than 80% of the life insurance 

business is from these products 2) Fire Insurance 3) Marine Insurance 
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Introduction to E-commerce : 

The exchange or buying and selling of commodities on a large scale involving transportation from place to place is 

known as commerce. When all this is done electronically, it is known as “e-commerce”. E-commerce from 

communication perspective is the delivery of information, products or services, or payments via telephone lines, 

computer networks, or any other means-commerce from business perspective, is the application of technology 

toward the automation of business transaction and workflows. Ecommerce from online perspective provides the 

capability of buying and selling products and information on the Internet and other online services.  

Features of e-Commerce  

• e-Commerce is doing business online and electronically • e-Commerce is about buying and selling products and 

services on the Internet. • The sellers are individuals, small businesses or large corporations. • The buyers are 

consumers or businesses. • Payment can be made by credit or debit card, money order, cash, check, services or 

trade. • The ranges of things that can be sold using e-commerce is enormous and include art, apartment, antennas, 

batteries ,bicycles, books, cars, cells phones, computer, cosmetics and whatever. 

Role of E-Commerce  

1. E-commerce is one of the cheapest means of doing business as it is e-commerce development that has made it 

possible to reduce the cost of promotion of products and services.  

2. E-commerce reduces delivery time and labor cost thus it has been possible to save the time of both – the vendor 

and the consumer.  

3. You can do your e-payments with the help of e-commerce.  

4. You can pick up the pace of your online business with the help of e-commerce application  

5. There is no time barrier in selling the products. One can log on to the internet even at midnight and can sell the 

products at a single click of mouse.  

6. E-Commerce provide facility - on-time alerts are meant for the convenience of the consumers and inform the 

consumers about new products.  

E-commerce Framework: 

 The e-commerce framework offers a set of options to the customers. Most of the electronic commerce plans have 

different strategies for security and privacy, their skill to deal with the payments, and their usability to different 

transactions Framework tells about the detail of how e-commerce can take place. It defines actually how e-
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commerce implemented, how online trading or business can be done. It defines important components that should 

be present to do some transaction.  

Framework of e-commerce can be viewed as shown below:-  

The important components of this framework are:   

1. Network Infrastructure is called as “INFORMATION SUPERHIGHWAY” - is the path through which actual 

information flows and moves between sender and receiver. Information Superhighway consists of 

telecommunication companies that provide telephone lines.Multimedia Contents And Network Publishing- The 

Information Superhighway is the transportation foundation that enables the transmission of content. The most 

prevalent architecture that enables networking publishing is the World Wide Web. The web allows small 

businesses and individuals to develop content in the form of Hypertext Markup Language (HTML) and publish it 

on a web server. Web provides a means to create product information (content) and a means to publish it in a 

distribution center. ( network server).  

3. Messaging And Information Distribution Infrastructure- The information content transferred over the 

network consists of text, numbers, pictures, audio and video. But the network does not differentiate among content 

as everything is digital, that is, combinations of zero’s and one’s. Once contents has been created and stored on a 

server, messaging and information distribution methods carry that content across the network. Messaging vehicle 

is called middleware software. Messaging and information distribution include translators that interpret and 

transforms data formats.  

4. Common Business Services Infrastructure - This infrastructure includes the different methods for facilitating 

online buying and selling processes. In online commerce, the buyers sends an electronic payment as well as some 

remittance information to the seller. Settlement occurs when the payment and remittance information are 

authenticated by the seller and accepted as valid. In order to enable online payment for information and ensure its 

safe delivery, the payment services infrastructure needs to develop encryption (making contents indecipherable 

except for the intended recipient) and authentication (making sure that customers are who they say they are) 

methods that ensure security of contents traveling on the network.  

5. Public Policy And Technical Standards- Public Policy And Technical Standards are two support pillars for all 

e-commerce applications and infrastructure. Public policy related to e-commerce encompasses such issues as 

universal access, privacy and information pricing. Technical Standards dictate the specifics of information 

publishing tools, user interfaces and transport. Standards are essential to ensure compatibility across the entire 

network of world.  

 

 



 

 

                   DNYANSAGAR ARTS AND COMMERCE COLLEGE, BALEWADI,PUNE–45 

Subject : Computer Concepts and Applications (sub code : 114(B) CBCS 2019-20 Pattern ) 

 Class : F.Y. B.Com 

Prof . S. B. Potadar                                                                                                                                        www.dacc.edu.in 

E-Commerce Categories : 

The two most common participants in ecommerce are businesses and consumers. Based on this we can come up 

with four primary ecommerce types:  

1. Business to Business Ecommerce (B2B Ecommerce) In this type of ecommerce, both participants are 

businesses. As a result, the volume and value of B2B ecommerce can be huge. An example of business to business 

ecommerce could be a manufacturer of gadgets sourcing components online.  

2. Business to Consumer Ecommerce (B2C Ecommerce) When we hear the term ecommerce, most people think 

of B2C ecommerce. That is why a name like Amazon.com pops up in most discussions about ecommerce. 

Elimination of the need for physical stores is the biggest rationale for business to consumer ecommerce. But the 

complexity and cost of logistics can be a barrier to B2C ecommerce growth.  

3. Consumer to Business Ecommerce (C2B Ecommerce) On the face of it, C2B ecommerce seems lop-sided. 

But online commerce has empowered consumers to originate requirements that businesses fulfill. An example of 

this could be a job board where a consumer places her requirements and multiple companies bid for winning the 

project. Another example would be a consumer posting his requirements of a holiday package, and various tour 

operators making offers.  

4. Consumer to Consumer Ecommerce (C2C Ecommerce) The moment you think of C2C ecommerce 

eBay.com comes to mind. That is because it is the most popular platform that enables consumers to sell to other 

consumers. Since eBay.com is a business, this form of ecommerce could also be called C2B2C ecommerce 

(consumer to business to consumer ecommerce). 


